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• Released May 2013
• Not so new!

• Runs anywhere that has Java™
• Java 1.6 or later

• Current Java 1.8 Recommended

• This includes:

• Windows
• Mac
• Linux

• AIX
• IBM i

IBM i ACS – New Client

© 2016, 2017 IBM Corporation

Cognitive Systems

• IBM i Access Client Solutions

– The core of the product is a Java client that is not platform specific.

– Runs on most full featured client/server Operating Systems that support 

Java 6.0 or higher such as most versions of Windows, Mac and Linux.

– Same deployment, configuration, settings, problem determination across all 

platforms.

– Features include:

• 5250 Display and Printer Emulation

• Printer Output

• Integrated File System

• Data Transfer & Database Tools (SQL Scripts, Visual Explain, Schemas)

• 5250 LAN Console and Virtual Control Panel

• SSH Terminal Integration

IBM i ACS
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• Base Package (Platform Independent)
• 5250 display and printer emulator

• Data transfer

• Printer Output

• Console consolidation

• Many other features

• Windows Application Package
• Windows Installer MSI Package

• Data drivers (ODBC, OLEDB, .Net)

• Printer drivers

• Linux Application Package
• RPM and Debian Install Packages

• ODBC driver

IBM i ACS – 3 Products in 1

© 2016, 2017 IBM Corporation
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• IBM i Access for Windows or Client Access has been the platform for nearly everything 

needed to interact with your IBM i OS for a long time.  From end users just needing a 5250 

session, to a System Administrator, the same product and maintenance overhead is needed

• Many of these functions are now available in different ways depending on the needs of the 

user or application environment.

• Access for Windows

major functions and

where those functions

are provided

Decoupling Access for Windows
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Why the Change?

© 2016, 2017 IBM Corporation

Cognitive Systems

• Windows only solution….mid 90’s
• Primary interface for many
• 5250 emulator
• Console 
• OS Management 

• Much more

12

IBM i Access for Windows
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IBM i Access for 

Windows

- 5250 

- Console

- Data Transfer

- ODBC, .Net, etc.

- GUI Navigator 

- Spool file 

- IFS file transfer

- PTF Management

- Dashboard 

- Run SQL Script

- Visual Explain 

- API's

- …

IBM I Access for 

Linux

- 5250  (it was terrible)

- ODBC

Windows no longer is the only OS or device that is required 

What did we have in the past?

© 2016, 2017 IBM Corporation

Cognitive Systems Strategy 

Windows 

Install 

Only  Any Device 
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Core issues 
• No support for Linux & Mac 

• No support for Mobile 

• Difficult to deploy for many users 

• Difficult to update 

• Development is costly 

• Existing support is OLD – The world has changed!

© 2016, 2017 IBM Corporation
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Solution themes  
• Device & OS Neutral 

• Flexible 

• Easy to install and maintain 

• Simple for a single user or 1000’s 

• Improved administrator situation 

• Cost effective to create 

Answers
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IBM i Access Family

– IBM i Access for Windows (5770XE1)
• Client Access

• Most mature and widely used product

- System i Navigator

- 5250 Display and Printer Emulation

- Data Transfer

- Operations Console & Virtual Control Panel

– IBM i Access for Web (5770XH2)
• IBM i System Hosted HTML based web product

• Very robust capability that has been well received

- 5250 Display

- Print Access

- Database Access

– IBM i Access for Linux (5770XL1)
• Lightly embraced product specifically for Linux RPM Operating Systems

- ODBC provider

- 5250 Display

- Remote Command

– Data Access 

Providers

– Remote 

Command

– Print Drivers

– Integrated File 
System

– Commands

– Jobs

© 2016, 2017 IBM Corporation
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Where are we now and for the future?

IBM i ACS Base
- 5250 

- Console

- Data Transfer

- Spool file 

- IFS file transfer

- Run SQL Scripts

- Visual Explain

IBM i ACS Win AP
- ODBC, .Net, OLEDB Drivers

- APIs

Navigator for i
- PDI 

- PTF 

- Database 

-Gui Interface 

ARE
- Multi System Mgt

- PTF distribution 

IBM i ACS Base
- 5250 

- Console

- Data Transfer

- Spool file 

- IFS file transfer

- Run SQL Script

- Visual Explain

IBM i ACS Linux AP
- ODBC

Navigator for i
- PDI 

- PTF 

- Database 

-Gui Interface  

ARE
- Multi System Mgt

- PTF distribution 

IBM i ACS Base
- 5250 

- Console

- Data Transfer

- Spool file 

- IFS file transfer

- Run SQL Script

- Visual Explain

Navigator for i
- PDI 

- PTF 

- Database 

-Gui Interface  

ARE
- Multi System Mgt

- PTF distribution 

IBM i Access Mobile
- 5250 

- GUI Management 

- DashBoard

- Run SQL Statement



11/16/2017

10

© 2016, 2017 IBM Corporation

Cognitive Systems

How do you get it ???

http://www.ibm.com/systems/power/software/i/access/solutions.html

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview
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• What is it supported connecting to?

– Supported connecting to IBM i OS r7.3, r7.2, r7.1 and r6.1

• Do I need any extra licenses? Any extra ports, protocols?
– No, IBM i OS supports IBM i Access Client Solutions exactly the same as IBM i Access for 

Windows

– Checks out the same 57xxXW1 Licenses for 5250 and Data Transfer

– Connects to the same IBM i Access Host Servers on the same ports in the same way

• Exit programs will continue to have the same impact

• Application Administration local policies will still be applied

• Do I need to uninstall IBM i Access for Windows first? 

– For ACS core offering, no

– For the Windows Application Package, yes. 

Common Questions

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview: 
Connection Configuration
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• Use the System Configurations panel to store connection information 
on the IBM i Systems that will be used

System Configurations

© 2016, 2017 IBM Corporation
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• Create, Edit or Delete connection information for IBM i Systems that 
are used.

– System Name:  What is entered by the user to connect to this host

– IP Address:  What the PC’s DNS environment last returned when 
connecting to the System Name

– Service Host Name:  The System’s Console host name or IP address 
as configured

– Description

System Configurations
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• OK - Saves the information entered and closes the panel
• Save/New - Saves the information entered and clears the panel
• Cancel - Closes the panel without saving anything

System Configurations

© 2016, 2017 IBM Corporation

Cognitive Systems

• Use SSL specifies that the connection will be secured
• If the Certificate Authority negotiated is not trusted, the user will be prompted to add to trusted 

list
• There still is a Key Management utility if needed

System Configurations - SSL
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• Use default user name to prompt once for each system
– Caches credentials for duration of desktop session

• Prompt for user name and password every time

• Use Shared credentials
– First time for desktop session that a connection is made to a

System configuration using this option the user will be
prompted to provide User name & Password

– These credentials will be cached for use by all System
configurations set to this option

• Use kerberos authentication; do not prompt
– No further IBM i Access Client Solutions configuration needed

System Configurations - Authentication

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview: 5250 Emulation
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• Opens an Enhanced 5250 Telnet Emulator session to the current System

5250 Emulation

© 2016, 2017 IBM Corporation

Cognitive Systems

• Provides nearly identical interaction, look and feel to the Access for Windows 
PC5250 emulator
– Keyboard Mapping
– Keystroke Macros
– Edit Colors
– Toolbar Customization
– Pop-Up keypad
– Window Setup
– Hotspots
– Printer Emulation

• Also some New features
– Tabbed Sessions
– Mouse Wheel
– Simplified Codepage
– Screen History
– Watermarks
– Default Session

5250 Emulation



11/16/2017

16

© 2016, 2017 IBM Corporation

Cognitive Systems

31

Access for Windows – PC5250 ACS – 5250 Emulator

Let’s Talk More about the Emulator

© 2016, 2017 IBM Corporation

Cognitive Systems

32

Mouse Wheel !   Touch Pad  !!

Mouse wheel 

recognition!

Touch Pad 

Too!!
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• Edit->Preferences->Mouse Wheel

Mouse Wheel !   Touch Pad  !!

© 2016, 2017 IBM Corporation

Cognitive Systems

34

Mouse wheel options – How Wayne likes it!!

Why?

Mouse Wheel !   Touch Pad  !!
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Watermark Support

© 2016, 2017 IBM Corporation

Cognitive Systems

36

Watermark Support
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Watermark Support

© 2016, 2017 IBM Corporation
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Watermark Support
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Watermark Support

© 2016, 2017 IBM Corporation
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40

Watermark Support



11/16/2017

21

© 2016, 2017 IBM Corporation

Cognitive Systems

41

Image watermarks

Center, tile, 

or stretch!

© 2016, 2017 IBM Corporation

Cognitive Systems

42

Text watermarks



11/16/2017

22

© 2016, 2017 IBM Corporation

Cognitive Systems

43

Text Watermark - Keywords

– &COMPN

Computer name

– &HOST

Host name defined within the emulator session

– &ID

Current session ID

– &NAME

Current session name

– &USERN

User name that started the JVM *NOT IBM i user profile

© 2016, 2017 IBM Corporation

Cognitive Systems

44
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TABS!

© 2016, 2017 IBM Corporation
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Many Tabs

• Drag them around (even between windows)

• Detach them to their own window

– Choose where to place them on the screen
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• Not enough room on the screen? NO PROBLEM!

TABS!

© 2016, 2017 IBM Corporation

Cognitive Systems

48

• Edit->Preferences->Tab Setup

Menu item, 

Tab Bar +, or 

<ctrl>+T

TABS!
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• Edit->Preferences->Tab Setup

TABS!

© 2016, 2017 IBM Corporation

Cognitive Systems
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Yes, you can switch between tabs with the keyboard

• <alt>+<tab> switches between windows

• <ctrl>+<tab> switches between tabs within a window

(you can customize)

• You can also define a key sequence for "Jump Next“

and "Jump Previous", which will traverse all

5250 sessions (different tabs and windows)

TABS!
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Reworked keyboard mapping interface

© 2016, 2017 IBM Corporation

Cognitive Systems
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Reworked keyboard mapping interface
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Reworked keyboard mapping interface

© 2016, 2017 IBM Corporation
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Screen History
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Screen History

© 2016, 2017 IBM Corporation

Cognitive Systems
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Screen History
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History Screen

• When clicked on a thumbnail, a new window would pop-up showing 

the contents of the navigated screen (history screen)

• One can also navigate the other history screens (if any) from a history 

screen, by using the next and previous button on it

57

Screen History

© 2016, 2017 IBM Corporation

Cognitive Systems

Screen History 

• Expanded from 15 

screens to unlimited

• Easy to use controls 

• Save the screens you 

want

• Click Stop to create a 

Archive file 

• View list of Files 

Screen History - Archive
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Print all the 

Screens to 

Text File

Create many files and open 

the screen viewer

Screen History - Archive

© 2016, 2017 IBM Corporation

Cognitive Systems

60

Easily launch Other ACS Functions
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Default Profile

© 2016, 2017 IBM Corporation

Cognitive Systems

62

Default Profile

• Your current preferences will now be set as the default settings for all 

new 5250 sessions you create! 

• This includes (but is not limited to)

– Key mappings

– Color mappings

– Watermark settings

– Screen history

– SSL setting

– Bypass signon

– Screen Size (27x132)
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Functional Overview: Data Transfer

© 2016, 2017 IBM Corporation

Cognitive Systems

• Select the Data Transfer option

– Will default to the current System

Data Transfer
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• Displays the Data Transfer interaction panel

– Starts out with a Data Transfer to IBM i and Data Transfer from IBM i tab to 
the current System on the main panel

Data Transfer

© 2016, 2017 IBM Corporation

Cognitive Systems

• Data Transfer interaction panel

– Starts out with a Data Transfer to IBM i and Data Transfer from IBM i tab to 
the current System on the main panel

– All active Data Transfer requests are displayed in a tab on this panel

– Open Saved Requests

– Save Requests

– Create IBM i Files

– Data Transfer Migration

Data Transfer
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• Data Transfer mechanism to interact directly with spreadsheet

– On a Data Transfer From IBM i Select “Active Excel Spreadsheet” for the 
output device.

– Data Options can be used to modify query

Data Transfer

© 2016, 2017 IBM Corporation

Cognitive Systems

• Data Transfer mechanism to interact directly with spreadsheet

– The results of the data transfer are placed into the active Excel spreadsheet 
book at the currently selected cell.

Data Transfer
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• Data Transfer mechanism to interact directly with spreadsheet

– On a Data Transfer to IBM i Select “Active Excel Spreadsheet” for the Input 
device.

– The selection from the Excel Spreadsheet will be uploaded to the file on the 
IBM i

Data Transfer

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview: Console
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• 5250 Console – Opens a interactive console to the current System

• Virtual Control Panel – Opens a Virtual Control Panel

Console

© 2016, 2017 IBM Corporation

Cognitive Systems

• 5250 Console

Console
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• Virtual Control Panel

• Service Functions
– Providing options for service

commands instead of providing
the up and down arrows and enter

• Supported with BOTH
LAN and HMC console types

Console

© 2016, 2017 IBM Corporation

Cognitive Systems

• Console Configuration

• Only Client Console
supported with
r7.3 IBM i OS

– LAN Console

Console
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Functional Overview: Printer Output
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• Lists and allows interaction with the printer output on the IBM i OS System

Printer Output
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• Printer Output user interface

– Allows the user to view, and download spooled files.

Printer Output

© 2016, 2017 IBM Corporation

Cognitive Systems

• Edit -> Preferences

– Download location

• Where the downloaded file will be stored on the local workstation

– Other

• Determines if the printed output should be downloaded in PDF format if 

available

- Requires IBM i OS r7.1 or later with the IBM Transform Services for i (5770TS1) product 

installed

- If this is unchecked a

.txt file will be generated

Printer Output
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• View -> Set Filter

– Allows the user to specify how the list of printed output is generated.

– Either the User, Output Queue or both filters may be modified.

Printer Output

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview: Integrated File System
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• Lists and allows interaction with the Integrated File System on the IBM i
OS System

Integrated File System

© 2016, 2017 IBM Corporation

Cognitive Systems

• Integrated File System user interface

– Allows the user to interact with IFS files and directories.

Integrated File System
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• Edit -> Preferences

Integrated File System

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview: Database Tools
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Run SQL Scripts

Highlights:
• Faster Startup Time
• Line Numbers
• Highlighting 
• Color Coding

• Improved Usability
• Status Bar 
• Reconnect
• Editor features
• Save Results
• Graphical Debugger
• Built-in examples

Database Tools

© 2016, 2017 IBM Corporation

Cognitive Systems

Visual Explain

• Better than before

– Search

Launch from:

• Run SQL Scripts

• Analyze

• Show Statements

Database Tools



11/16/2017

44

© 2016, 2017 IBM Corporation

Cognitive Systems

Schemas in ACS

ACS-based Actions:
• Definition
• Description
• Generate SQL
• Properties

• Rename
• New Database Object
• Explain
• Data

o View, Clear, ...
• Actions in 

Visual Explain
• …

Database Tools

© 2016, 2017 IBM Corporation

Cognitive Systems

ACS Version 1.1.7.1 (July, 2017)
• General

– Add Database Health Center
– Add help text to dialogs

• Run SQL Scripts

– Add Performance Monitor pulldown

– Direct launch buttons
– More Insert from Examples

• SQL Performance Center
– Import SQL Performance Monitor
– Import SQL Plan Cache Snapshot

– Import SQL Plan Cache Event 
Monitor

– New SQL Performance Monitor
– New SQL Plan Cache Snapshot
– New SQL Plan Cache Event Monitor

• Schemas

– Journal - View Entries

– Add Include... filtering support 
for Tables and Indexes

– All Objects - Permissions 
action

Database Tools
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ACS Version 1.1.7.2 (October, 2017)
• Database Maintenance Lists

– Alter Tables

– Index Builds

– Reorganize Physical File Member

– Other long running DB operations

• Schemas

– More actions

– More columns for Tables

• Run SQL Scripts

– Custom Border Settings

– More Insert from Examples

Database Tools

© 2016, 2017 IBM Corporation

Cognitive Systems

Insert From Examples

Database Tools
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1) Add the following comments to your Run SQL Script.

-- category:  Demo Scripts

-- description: Demonstrate Guardium Database Activity Monitor

2) Save the script to the following path.

C:\Users\<your-
user>\Documents\IBM\iAccessClient\RunSQLScripts\Examples

3) Find your script with Search or via the Examples pane.

Adding examples to Run SQL Scripts

Database Tools

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview: SSH Terminal
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Easy access to you 

favorite shell 

Your new ‘qsh’ ! 

SSH Terminal

ACS Version 1.1.7.2 (October, 2017)

© 2016, 2017 IBM Corporation

Cognitive Systems

Functional Overview: Navigator
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Operations Navigator

iSeries/System i Navigator

IBM Navigator 

for i

Systems Director Navigator

1995

V5R3

V6R1

Jan 2013
Dec 2015

TimeLine

© 2016, 2017 IBM Corporation

Cognitive Systems

• IBM i Access Client Solutions does not provide any Navigator interface 

instead relying on the IBM Navigator for i web based infrastructure that 

was introduced with IBM i OS r6.1 and has continually been enhanced since

– Name change from IBM Systems Director Navigator to IBM Navigator for i

indicates a very large investment into improving the performance and usability 

of this interface

– Key IBM i OS solutions like Performance Data Investigator and HAS tools are only 

available in Navigator for I

– r7.2 GA timeframe introduces monitors and PTF interaction

– A few things have had reliance on System i Navigator

• Run SQL Scripts (NOT Anymore, Delivered December 2015)

• Database Visual Explain (NOT Anymore, Delivered August 2016)

• Management Central Multiple System Interaction (Monitors, Fixes, etc.)

IBM i Access Client Solutions & Navigator
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IBM Navigator for i

© 2016, 2017 IBM Corporation
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98

Performance Tasks
� “Performance” is a major function within this Web console

– Investigate Data
“Performance Data Investigator”

– Collections

– All Performance Tasks

• Active Jobs

• Disk Status

• System Status

• Define, start, stop and 
manage performance data collectors
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Investigate Data
Folders (content packages) contain Perspectives (views)  and 
are a logical grouping of related charts/tables that benefit from 
being rendered side-by-side for reference or context.  

Health Indicators (based 
off of Collection Services 
data) – a great way to 
assess overall health of 
your system

IBM Performance Tools (option 3) 
Job Watcher feature 

NEW – SQL 
Performance Data!!

© 2016, 2017 IBM Corporation

Cognitive Systems

100

Health Indicators
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Collection Services 

• CPU Utilization and Waits Overview

© 2016, 2017 IBM Corporation

Cognitive Systems
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Job Watcher – CPU Utilization and Waits Overview



11/16/2017

52

© 2016, 2017 IBM Corporation

Cognitive Systems

103

Disk Watcher – Disk Statistical Overview

© 2016, 2017 IBM Corporation

Cognitive Systems

104

Performance Data Investigator – New Database Perspective

• Robust graphical 
interface enabled 

by Collection Services 
support.

• New breakdown makes 

it easier to notice “what 
changed”?
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Database tab - Basics
Work with database

Database 
Indexes

Database Health Center

© 2016, 2017 IBM Corporation

Cognitive Systems

106

ACS & Navigator 

No extra sign-on !!
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Run SQL Scripts

• Launch from Navigator to ACS

• Super new Run SQL Scripts

© 2016, 2017 IBM Corporation

Cognitive Systems
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Create Monitors

• Monitor System Performance Metrics 

• Set thresholds 

• Take actions when threshold is reached  

• Or when it goes under

• Monitor for Messages 
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• Coordinate scrolling

• Show Thresholds – display 
trigger and reset values 

• Adjust layout – columns

System Monitors – All Metrics

© 2016, 2017 IBM Corporation

Cognitive Systems
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PTF Compare and Update

• Compare PTFs and PTF groups on different systems

• Send and install PTFs/PTF groups to multiple systems

• Multi-system PTF comparison



11/16/2017

56

© 2016, 2017 IBM Corporation

Cognitive Systems

111

• New search menu 

• Enter a phrase, CL Command, idea 

• Corresponding options are displayed 

• Click and go directly there 

Find What You are Looking For

© 2016, 2017 IBM Corporation
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112

• Create your own navigation list 

• Click on any Table, ‘Save as Favorites’ 

• Enter your tree node

• Create the name 

Favorites
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Set Target System
� Set Target System

– Specify the remote system you want to work with. 

– Supports system at all supported releases

� Specify System 

Name

� User ID

� Password

� Click OK

� *Close / Restart 
Open tabs

Current system being 
managed!!!

© 2016, 2017 IBM Corporation
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Why Set Target System  ?
• Allows for a client server relationship

• Run Navigator on one system, manage any other system in your 

network

• Means you DON’T need to run navigator on your production machine 

Navigator 
System 

Set target system

Production A

Production B

QA
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Functional Overview: IBM i ARE
Administration/Application Runtime Expert

© 2016, 2017 IBM Corporation

Cognitive Systems

Why use it?

• Enhanced Serviceability 

– Run on failing system to identify and fix problems

– One tool to check the entire software stack

• Runtime Expert checks everything, every time

• Product Testing

– Understand product installation

• Build verification

• System Validation

– Ensure your systems are in expected state

– Help debug issues with your own systems

• Pre-requisite Checking

– Most software products have pre-reqs – ARE can check these for you

• Schedule Automatic Verifications

IBM Application Runtime Expert for i
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• Compare PTF levels across systems
• Compare PTF levels against IBM cloud
• Send PTF's from one system to another via *SAVF
• Load PTF's from image catalogs
• Scheduled PTF verifications
• Send an email when something is wrong
• Compare an endless number of other system attributes

Tools for Managing PTFs

© 2016, 2017 IBM Corporation
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Central system – image catalog dist. (multiple releases)

6.1

7.2

7.1

Catalog

Image

Catalog

Tools for Managing PTFs
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• GUI LPP – 5733ARE
– Runs on IBM i 6.1 and higher
– Very reasonably priced!
– Now a No Charge Feature!

• Core is part of the base OS
– Available on IBM i 5.4 and newer
– Apply latest HTTP and Java Group PTFs

• Articles
– Turning Big Problems Into Small Ones  

http://www.ibmsystemsmag.com/ibmi/application_runtime_expert/33004p1.aspx
– You and i – ARE Solving Problems  http://ibmsystemsmag.blogs.com/you_and_i/2010/07/you-and-i-are-solving-

problems.html
– Do You Need an Application Runtime Expert? http://ibmsystemsmag.blogs.com/idevelop/2010/07/do-you-need-an-

application-runtime-expert.html

• Product Web site contains install instructions, fix information, and documentation
– http://www.ibm.com/systems/power/software/i/are/index.html

How do you get it?

© 2016, 2017 IBM Corporation

Cognitive Systems

Deployment
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• IBM i Access Client Solutions is identified as LPP 5733-XJ1

– Not an IBM i OS installable LPP

• The GA version of the product is available to customers with valid 
SWMA and IBM i OS r6.1, r7.1 or r7.2 and is downloaded from the IBM i
Access Client Solutions or IBM Entitled Software Support (ESS) websites

– Technote with example instructions

• http://www-01.ibm.com/support/docview.wss?uid=nas8N1010355

• Product distributed in zip files

– Platform Independent Core Java product
• From IBM i ACS website:  IBMiAccess_v1r1.zip

• On ESS:  IBM_i_Access_Client_Solutions_LCD#_*.zip

• Contains product jar and other supporting files

Product Availability
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• Main User Interface provides an easy to use launch point for features

• Product contains Documentation folder containing "QuickStartGuide" and 
"GettingStarted" documents

• "GettingStarted" can also be launched from Main User Interface

Documentation
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• IBM i Access Client Solutions is not installed to the client operating 
system, it is deployed.

– There is no Windows Based Installer (setup.exe) installation program for the core of 
the product.

• Access Client Solutions Deployment
– The deployment involves the client bundle being placed wherever it is desired to be 

executed from, and determining where the product settings are going to be stored.

• Client Bundle
– Contains the Java executable Jar, properties file, platform specific start executables

and javascript start samples, product documentation, and licensing notices.
– All that is required to be deployed is the Java executable Jar
– The rest is optional

• No JRE distributed
– IBM i Access Client Solutions does not deploy a specific JRE
– Relies on a Java 1.6 or higher (Java 1.8 recommended) JRE to be accessible on the 

client OS

Deployment
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• When thinking about deployment, ask yourself where you want to put:

1. the product image? (jar file)

2. the user’s settings? 
(system configurations, 

5250 sessions, etc.)

Deployment: Initial Questions
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Computer (local)

Network Share

USB Thumb Drive

Intranet (http:// URL)

Deployment: Options
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What you get in the package

Deployment
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Start Programs – Operating System specific launch executables

Deployment
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Start Programs – Operating System specific launch executables

Deployment
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• IBM i Access Client Solutions provides Operating System specific Application deployment scripts 

to make deployment easier for an user

• Javascript will copy the IBM i Access Client Solutions deployment to a specific location that makes 

sense for the Operating System being used.

Provided Deployment/Install Scripts
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• Provided install_acs script on Windows will copy the IBM i Access Client Solutions deployment to 

C:\Users\<WindowsUser>\IBM\ClientSolutions.

• Provided install_acs_*_allusers script will copy the IBM i Access Client Solutions deployment to 

C:\Users\Public\IBM\ClientSolutions

• Deployment will ask the user which functions they want to use, if it should create shortcuts on 

the Desktop for the Main User Interface and 5250 Session Manager.  It will also create file 

associations for the .hod, .bchx, .dttx & .dtfx if they haven’t already been created.

Provided Windows Deployment/Install Script
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• Deployment Prompts

Provided Windows Deployment/Install Script
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Provided Windows Deployment/Install Script

• Deployment Prompts
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• Deployment Prompts
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Provided Windows Deployment/Install Script

• Deployment Prompts
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Provided Windows Deployment/Install Script

• Deployment Prompts
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Provided Windows Deployment/Install Script

• Deployment Prompts



11/16/2017

70

© 2016, 2017 IBM Corporation

Cognitive Systems
Provided Windows Deployment/Install Script

• Deployment Prompts

© 2016, 2017 IBM Corporation

Cognitive Systems
Provided Windows Deployment/Install Script

• Deployment Prompts
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Provided Windows Deployment/Install Script

• Deployment Prompts
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Provided Windows Deployment/Install Script

• Deployment Prompts
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• IBM i Access Client Solutions v1r1m4 Update 3 (October 2015) provided an update to these 
deployment scripts for Windows to allow an Administrator to control some of the deployment 
behavior and how the client behaves for the user.

– An Administrator runs the script passing a parameter of   /AdminConfig

• The Administrator is then presented with a series of questions about the deployment, 
like if ACS should be ran locally or remotely, what functions will the user have, and if 
desktop icons should be created.

– The IBM i Access Client Solutions product files are placed in a central location

– Users run the deployment script and IBM i Access Client Solutions is deployed to their 
Windows workstation.

• More Details

– https://www.ibm.com/developerworks/ibmi/library/i-ibmi-access-client-solutions-
customization-trs/

– http://www-01.ibm.com/support/docview.wss?uid=nas8N1020967

Provided Deployment Scripts
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• Administrator Preparing Deployment

Provided Deployment Scripts
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• Administrator Preparing Deployment

Provided Deployment Scripts
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• Administrator Preparing Deployment

Provided Deployment Scripts
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• Administrator Preparing Deployment

Provided Deployment Scripts
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• Administrator Preparing Deployment

• Where should the product be ran from?

• No => Copy the IBM i ACS deployment to Windows User’s Home Directory

– To update the product, update the central location and re-run install script

• Yes => Run the product from the location the install script is being ran from

– May be a Network or Local location

– To update the product just update the deployment location via file copy

Provided Deployment Scripts
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• Administrator Preparing Deployment

Provided Deployment Scripts
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• Administrator Preparing Deployment

Provided Deployment Scripts
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• Administrator Preparing Deployment

• User running the Deployment

• Deployment scripts supports a /Q option to be passed to the script to silently 
deploy the client.  Automatically accepting the End User License Agreement and 
not showing this completion message.

Provided Deployment Scripts
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• Provided install_acs Javascript on Mac will copy the IBM i Access Client Solutions deployment to 

the Mac OS Applications folder.

Provided Mac Deployment/Install Script
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• Provided install_acs Javascript on Linux will copy the IBM i Access Client Solutions deployment to 

the locations of

– /usr/share/applications/

– /opt/ibm/iAccessClientSolutions/

Provided Linux Deployment/Install Script
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Migration
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• IBM i Access Client Solutions provide several tools to assist with migrating from 

the IBM i Access for Windows client environment to IBM i Access Client 

Solutions

– 5250 Migration Tools

• Workstation file and keyboard map migration

• Macro migration

• Legacy File Associations

– Data Transfer

• Saved Data Transfer migration

– System Connections

Migration
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• 5250 Session Manager

5250 Migration
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Migration – 5250 session profiles

5250 Migration
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Migration – 5250 session profiles

5250 Migration
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• Key mappings are also converted. A converted .kmp file will be saved in 

the same location that the new .hod file is created and will be referenced 

by that .hod file.

5250 Migration

Migration – 5250 session profiles
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What about my old macros?

• File->Convert Macro

• VBScript capabilities NOT converted

5250 Migration
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• Create File Association for IBM i Access for Windows saved .ws or .bch 
file to be opened with IBM i Access Client Solutions  

5250 Migration
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Data Transfer Migration
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• Migrates saved .dtt and .dtf files to IBM i Access Client Solutions .dttx and .dtfx files

Data Transfer Migration

© 2016, 2017 IBM Corporation

Cognitive Systems

• Results of Migration

– Green check indicates success

– Red x indicates failure and there are more details

Data Transfer Migration
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• IBM i Access Client Solutions Copy Connections can be used to move System Configurations

Migration - System Connections
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What have we learned?
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• IBM i Access for Windows?

– Future not so bright

• Replacement for functions (big picture)?

– Combination of ACS core offering, ACS application packages, 

Navigator for i, Application Runtime Expert (ARE), IBM i Access for 

Web/Mobile 

• How to live without System i Navigator?

– Common "access" tasks can be completed with only the AP

– Others can be easily done with command-line utilities or the ACS 

base offering

What have we learned

© 2016, 2017 IBM Corporation

Cognitive Systems Summary

• Times, They are a Changing

• Why the Change?

• Functional Overview

– Connection Configuration

– 5250 Emulation

– Data Transfer

– Console

– Printer Output

– Integrated File System

– Database Tools

– SSH Terminal

– Navigator

– IBM i ARE

• Deployment / Migration

• Summary
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Questions
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SUBMIT A REQUIREMENT

• Be part of the voice to IBM – help enhance the IBM i and AIX 

operating systems

• Submit feature requests and requirements to IBM

Submit online at 

https://ibm.co/

2oLNF3v

or scan this 

QR code

172

Submit online at 

requirements.

common.org 

or scan this 

QR code

Submit COMMON Requirement 

for IBM i on IBM RFE site:

Submit COMMON Requirement 

for AIX on COMMON site:
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Useful links

• Access Client Solutions

– http://www-

03.ibm.com/systems/power/software/i/access/solutions.html

• Administration Runtime Expert (ARE)

– http://www-03.ibm.com/systems/power/software/i/are/

• IBM RFE community (submit requests to the "IBM i" product)

– https://www.ibm.com/developerworks/rfe/

© 2016, 2017 IBM Corporation

Cognitive Systems

https://facebook.com/IBMPowerSystems

https://twitter.com/IBMPowerSystems

https://www.linkedin.com/company/ibm-power-systems

IBM Power Systems Official Channels: 

http://www.youtube.com/c/ibmpowersystems

https://www.ibm.com/blogs/systems/topics/servers/power-

systems/

Power Systems Social Media
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More to Follow:

Blogs to Follow More to Follow Hashtags To Use

• IBM Systems Magazine You and I (Steve Will)

• IBM Systems Magazine i-Can (Dawn May)

• IBM Systems Magazine: iDevelop (Jon Paris 

and Susan Gantner)

• IBM Systems Magazine: iTalk with Tuohy

• IBM DB2 for i (Mike Cain)

• IBM DB2 Web Query for i (Doug Mack)

@IBMSystems
@COMMONug

@IBMChampions
@IBMSystemsISVs

@LinuxIBMMag
@OpenPOWERorg

@AIXMag
@IBMiMag

@SAPonIBMi
@SiDforIBMi

@IBMAIXeSupp
@IBMAIXdoc

#PowerSystems

#IBMi

#IBMAIX

#POWER8

#LinuxonPower

#OpenPOWER

#HANAonPower

#ITinfrastructure

#OpenSource

#HybridCloud

#BigData
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Special notices
This document was developed for IBM offerings in the United States as of the date of publication.  IBM may not make these offerings available in other countries, and the 
information is subject to change without notice. Consult your local IBM business contact for information on the IBM offerings available in your area.

Information in this document concerning non-IBM products was obtained from the suppliers of these products or other public sources.  Questions on the capabilities of non-IBM 

products should be addressed to the suppliers of those products.

IBM may have patents or pending patent applications covering subject matter in this document.  The furnishing of this document does not give you any license to these patents.  

Send license inquires, in writing, to IBM Director of Licensing, IBM Corporation, New Castle Drive, Armonk, NY 10504-1785 USA. 

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only. 

The information contained in this document has not been submitted to any formal IBM test and is provided "AS IS" with no warranties or guarantees either expressed or implied.

All examples cited or described in this document are presented as illustrations of  the manner in which some IBM products can be used and the results that may be achieved.  

Actual environmental costs and performance characteristics will vary depending on individual client configurations and conditions.

IBM Global Financing offerings are provided through IBM Credit Corporation in the United States and other IBM subsidiaries and divisions worldwide to qualified commercial and 

government clients.  Rates are based on a client's credit rating, financing terms, offering type, equipment type and options, and may vary by country.  Other restrictions may apply.  
Rates and offerings are subject to change, extension or withdrawal without notice.

IBM is not responsible for printing errors in this document that result in pricing or information inaccuracies.

All prices shown are IBM's United States suggested list prices and are subject to change without notice; reseller prices may vary.

IBM hardware products are manufactured from new parts, or new and serviceable used parts. Regardless, our warranty terms apply.

Any performance data contained in this document was determined in a controlled environment.  Actual results may vary significantly and are dependent on many factors including 

system hardware configuration and software design and configuration.  Some measurements quoted in this document may have been made on development-level systems.  There 

is no guarantee these measurements will be the same on generally-available systems.  Some measurements quoted in this document may have been estimated through 
extrapolation.  Users of this document should verify the applicable data for their specific environment.  

Revised September 26, 2006
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Special notices (cont.)
IBM, the IBM logo, ibm.com AIX, AIX (logo), AIX 5L, AIX 6 (logo), AS/400, BladeCenter, Blue Gene, ClusterProven, DB2, ESCON, i5/OS, i5/OS (logo), IBM Business Partner (logo), IntelliStation, LoadLeveler, Lotus, 
Lotus Notes, Notes, Operating System/400, OS/400, PartnerLink, PartnerWorld, PowerPC, pSeries, Rational, RISC System/6000, RS/6000, THINK, Tivoli, Tivoli (logo), Tivoli Management Environment, WebSphere, 
xSeries, z/OS, zSeries, Active Memory, Balanced Warehouse, CacheFlow, Cool Blue, IBM Systems Director VMControl, pureScale, TurboCore, Chiphopper, Cloudscape, DB2 Universal Database, DS4000, DS6000, 
DS8000, EnergyScale, Enterprise Workload Manager, General Parallel File System, , GPFS, HACMP, HACMP/6000, HASM, IBM Systems Director Active Energy Manager, iSeries, Micro-Partitioning, POWER, 
PowerExecutive, PowerVM, PowerVM (logo), PowerHA, Power Architecture, Power Everywhere, Power Family, POWER Hypervisor,  Power Systems, Power Systems (logo), Power Systems Software, Power Systems 
Software (logo), POWER2, POWER3, POWER4, POWER4+, POWER5, POWER5+, POWER6, POWER6+, POWER7, System i, System p, System p5, System Storage, System z, TME 10, Workload Partitions 
Manager and X-Architecture are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked terms are marked 

on their first occurrence in this information with a trademark symbol (® or ™), these symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information was published. Such 
trademarks may also be registered or common law trademarks in other countries. 

A full list of U.S. trademarks owned by IBM may be found at: http://www.ibm.com/legal/copytrade.shtml. 

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

AltiVec is a trademark of Freescale Semiconductor, Inc.

AMD Opteron is a trademark of Advanced Micro Devices, Inc.

InfiniBand, InfiniBand Trade Association and the InfiniBand design marks are trademarks and/or service marks of the InfiniBand Trade Association. 

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries 
in the United States and other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications Agency which is now part of the Office of Government Commerce.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Linear Tape-Open, LTO, the LTO Logo, Ultrium, and the Ultrium logo are trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries or both.

Microsoft, Windows and the Windows logo are registered trademarks of Microsoft Corporation in the United States, other countries or both.

NetBench is a registered trademark of Ziff Davis Media in the United States, other countries or both.

SPECint, SPECfp, SPECjbb, SPECweb, SPECjAppServer, SPEC OMP, SPECviewperf, SPECapc, SPEChpc, SPECjvm, SPECmail, SPECimap and SPECsfs are trademarks of the Standard Performance Evaluation 
Corp (SPEC).

The Power Architecture and Power.org wordmarks and the Power and Power.org logos and related marks are trademarks and service marks licensed by Power.org.

TPC-C and TPC-H are trademarks of the Transaction Performance Processing Council (TPPC).

UNIX is a registered trademark of The Open Group in the United States, other countries or both. 

Other company, product and service names may be trademarks or service marks of others.
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